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In this kind of economy and the global 
impact it has made, CAD managers must 
think about how to save their companies 
money. Saving money for your firm is one 
part of your job that you can never stop 
thinking about. You need to keep within 
budget, reduce outlays, and keep a lid  
on spending. 

I didn’t know if I wanted to start with 
this topic by telling you about how to save 
money or start by telling you that your main 
focus is to invigorate those who generate 
revenue for the firm. I do not want you 
to think that saving money is your eternal 
top priority. It is important, but you should 
never let it be your only focus. 

Your overarching focus should be to em-
power your users to know more, use the 
software better, create content quicker, 
avoid potholes in the process, and get the 
job out the door before it is due. This is 
your main trajectory. This should be what 
drives your thinking, your efforts, and  
your budget.

But there are times when you have to 
think in an expanded manner about saving 
money. So what can you do? How can you 
save? Here are a few areas that can bring 
some good returns.

Postpone whatever is not 
absolutely demanded

Most budgets are developed with a lot 
of breathing room. Mine includes a lot of 
“wish list” items that I will purchase if my 
firm is doing well. When times are good, 
these items are added to my available list 
of tools. Adding these items will benefit 
everyone and they are often the one item 
that has been desired by many for most of 
the past year. 

But when times are tough, you need 
to scale back. The first items to go are 
these wish list items. These items should 
be defined in your mind, but may not be 
flagged on your budget. They are the ones 
you wish you could purchase, but you are 

waiting until you have enough room in 
the spending plan to cushion the decision. 
Well, that cushion is most likely gone now. 
These days, every firm that I come into 
contact with is trying to find ways to save a 
few bucks. You need to help out with this 
process inside your firm.

This discussion is pointed toward post-
poning the purchase of those items that 
can be postponed. There are several items 
that cannot be postponed. Failing hard-
ware and faulty software are among them. 
If your users have outstripped their exist-
ing hardware or software, then upgrading 
it may not be an option. You may have to 
divert monies from one area to another to 
cover this need. 

Defining “needs” as opposed to “wants” 
is sometimes difficult. Keep in mind that 
everyone frames their “wants” as “needs.” 
It may be difficult to sift through the per-
spectives of others as they explain how 
much they NEED that software purchase 
or hardware upgrade. Ask yourself what 
will be gained from the purchase. Will it 
solve a real problem? Will the new soft-
ware fix a legitimate issue? These questions 
will need some hard thought as you try to 
separate the real issues from the ones that  
are overblown.

I typically ask these questions to narrow 
my thought process.

What will we gain from the purchase?•	
Is there something else we can purchase •	
that will get the job done cheaper?
What will be fixed by the purchase?•	
What will happen if we do not purchase •	
what someone “needs”?
Who will be impacted by postponing the •	
purchase?
Look for hard facts and not opinions. 

Facts overrule opinions. There may not be 
any factual information on some purchases 
and you will have to make the wisest deci-
sion you have based on what you know. 

Rethink everything you 
spend

When you do make a purchase, think 
long and hard about what you are buying. 
Think in the long term. Think about where 
you can get the most bang for the buck. 
Think about where you can make the larg-
est impact on the most people and projects 
for the least amount of money.

It may be time to act differently than 
you have in the past. Is it time to go on 
subscription services for software or may-
be to get off subscription? Subscripted 
maintenance, or whatever the vendor may 
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call it, allows you to be stable from a finan-
cial perspective because you know what 
the cost will be over the next few years. 
But in times like these, you may need to 
drop some of the subscriptions that you 
have and adopt a “pay as you go” plan. 
Paying for upgrades at the time of need 
is sometimes harder to justify when times 
are tough and reducing your subscriptions 
may cause future troubles when you really 
do need the upgrade and have to go beg-
ging for money.

Maybe you should see what is out there 
in the Open Source world. This may not 
impact your CAD dollars, but it will make 
some things easier on the wallet than drop-
ping big money on proprietary software. Or 
maybe you should think about upgrading 
your existing hardware rather than replac-
ing it. Adding RAM can squeeze a little 
more out of aging equipment. 

Do your homework on upgrades. Be 
ready to defend your purchases because 
they will be challenged. You need informa-
tion, test results, input from others, hard 
facts, and valid opinions to make the case 
for a purchase. Act as if it were your own 
money. Would you buy the product you are 
asking your firm to buy if it came out of 
your pocket?  It does come out of the same 
revenue stream that pays your salary, so in 
a way it is your money. In today’s economy, 
saving money saves jobs.

Renegotiate every contract 
you have

Now is the time to revisit every recur-
ring cost. Write down everything in your 
budget that is paid on an annual or month-
ly basis. Include software, hardware, sup-
port, consulting, and anything for which 
you are invoiced from the same provider 
every month or year.

What you are going to do is call each one 
of them and ask for a reduction in price. 
But first, do some prep work. Find out 
what you have and make sure that it is a 
current list. Find out how many licenses 
of software you own and how many are 
actually being used. If you have under-
purchased and actually have more in-
stalled than you own, then call them right 
now and buy those extra seats. Always stay 
within your license count. If you have an 
overage, then make a note of it and see 
what the impact would be if you reduced 
the annual support of those licenses. You 
may have to repurchase from scratch if you 
let them expire. Some developers allow li-
censes to be set aside and renewed in the 
future as part of an upgrade. It will usually 
cost you something if you let them lapse, 
but it may be a needed thing to do in the 
short term.

Stay close to the money people inside 
your firm. Get a history of the account 
processing before you contact the vendor. 
Are the bills being paid on time? Do the 
vendors have any outstanding invoices? 
Nothing kills your hopes of a good nego-
tiation more than having them tell you 
that the bill has not been paid for three 
months. Having a good standing with the 
vendor and being paid up, with a history 
of good payments, gives you leverage. You 
can appeal to the fact that you are a good 
customer and deserve a discount.

Speaking of invoices… are you review-
ing every invoice? Sometimes the ac-
counting department is disconnected from 
your discussions and does not know what 
the payments are for. Your company may 
be paying for something that you did not 
agree to. Always check invoices from time 
to time to make sure that costs have not 
creeped in that you did not approve.

Know their business. You need to do 
a little research on the companies with 
which you will be dealing. Check out the 
press releases on their websites. See how 
the business climate is for them and their 
product. If it is a new product that they 
are trying to get into the market, they may 
be willing to deal. If it is an older prod-
uct whose time may be passing, they may 
be willing to deal.  If they have just been 
bought out by a competitor, they may be 
willing to talk. Anything that you can find 
that will reflect their need for a sale will 
help you in your process.

Okay, now we are ready to take action. 
Take that list and start calling to renegoti-
ate your agreements. You can take several 
stances when you do this.

Play hard ball
Go in armed with your facts and per-

spectives and play it hard. Ask them to 
discount something or there is a strong 
possibility that you will have to take your 
business elsewhere. Do this only if there 
is somewhere else to take your business. 
Do not state that if they do nothing you 
will actually make a move. Just get them 
concerned that you might. If you threaten 
to move unless they give you some form 
of price break and then they do not, you 
will have to move or eat your words. This 
will make it impossible to ever play it hard 
with them again if you end up staying with 
them. They will know that you were bluff-
ing. So don’t do this unless you seriously 
have another contender in the running for 
your business. Never lie to a vendor – it 
isn’t moral, professional, or a good prac-
tice. Play it hard, but keep it honest. 

Play nice guy in need
You could play it nice to see what they 

can do for you. You will not get as good a 
discount as you might from playing it hard, 
but you may not be comfortable with play-
ing it hard. Playing nice does not have to 
be soft. You could plead your case with-
out begging or groveling. Keep it along 
the same lines as playing hard, but couch 
it in terms of your need to save money or 
you might have to cut something and you 
would not want to cut back on their con-
tract. There is never any harm in asking 
them to do better. I typically do not give 
them a hard figure that I am looking for. 
For example, I don’t say “cut it by $10,000.” 
I simply ask them to do better on the price. 
Remind them of your loyalty and love for 
their product. Remind them that you have 
been doing business with them for a long 
time. Keep it friendly. 

Appeal to their soft spots
Find the spots where they are weak or 

where they are trying to get strong. This 
is not an aggressive stance. It is one that 
appeals directly to their needs. They may 
need to sell one version of software. Or 
they may be nearing the end of their sales 
cycle. They may have bundled discounts 
when you buy multiple products. They may 
have a new product that they are trying to 
get into the market. They may be willing 
to partner with your firm to get some feed-
back or prime the pump of industry pen-
etration. Do your homework and you will 
uncover one of these areas that you can use 
to help get a better deal.

Conclusion
So when you are looking to save a few 

dollars, euro, or deutschmarks, keep some 
of these items in mind. By looking into 
what you have, what you need, and what 
the vendors are offering, you will find 
ways to reduce your outlay, improve your 
financial position, and generate a favorable 
standing from your firm.

Mark W. Kiker is president 
of the AUGI Board of Di-
rectors. He is a National 
CAD Standards Project 
Team Member and team 
member of the National 
BIM Standard. Mark is 

general editor of BLAUGI and also publishes 
caddmanager.com, the CADD Manager’s 
journal, as well as the caddmanager.com 
blog. He is a returning faculty member at 
Autodesk University. He is currently chief 
information officer for HMC Architects in 
Ontario, California, USA.
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Hear Ye, Hear Ye… all gather around. 
In March, Autodesk released the newest 
version of AutoCAD®. If this sounds fa-
miliar, it is for good reason. For the past 
five years, Autodesk has been releasing 
new versions of its software in March. 
This event has become more predictable 
than the groundhog’s indication of an  
early spring.

Let’s look back at the last couple of re-
leases. AutoCAD 2008 introduced new 
ways of working with annotation in drawings 
and AutoCAD 2009 brought a new user in-
terface, 3D navigation enhancements, the  
Action Recorder, and much more. 

With so many useful features and en-
hancements in the previous two releases, 
what could Autodesk find to pack into an-
other new release? AutoCAD 2010 does 
not implement anything new like using 
brain waves to command translation, but it 
does further refine 2D drafting and imple-
ments 3D mesh modeling. (I was hoping 
for the brain waves to command transla-
tion, though!).

User interface tweaks
For the most part, AutoCAD 2010 looks 

just like it did after the massive user inter-
face overhaul that came with AutoCAD 
2009. If you still have not come to terms 
with the ribbon in AutoCAD 2009, you will 
be happy to know the AutoCAD Classic 
workspace is still available.

One of the tweaks to the user interface 
that you will encounter is the menu brows-
er. Formerly, this feature was accessible by 

clicking the Application button, but it has 
been replaced with the application menu, 
which is more in line with the one found in 
Microsoft Office 2007. From the applica-
tion menu, you can quickly access recently 
or currently opened drawings as well as 
search for a command that you might have 
trouble locating on the ribbon. Figure 1 
shows the new application menu and the 
AutoCAD 2010 user interface.

Contextual ribbon tabs were introduced 
in the last release, but were limited to a 
select number of commands. AutoCAD 
2010 expands the use of contextual tabs 
to include certain commands and when-
ever an object in the drawing window is 
selected. Figure 1 shows the External 
References contextual tab displayed on 
the ribbon, but not active. In addition to 
the new application menu and contextual 

AutoCAD  
2010:
A New Twist 
on Design

Figure 1: New application menu and the AutoCAD 2010 user interface.

AUTOCAD
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tabs, the ribbon itself has received some 
minor tweaks of its own. Many of these 
are in the placement and grouping of com-
mands, designed to improve workflow  
and discoverability. 

The ribbon has also seen a new Express 
Tools ribbon tab (see Figure 2) that contains, 
what else, the Express Tools. Now, you will 
no longer need to display toolbars or the 
menu bar if you want to access the Express 
Tools when you are using the ribbon.

Parametrics to the rescue
Have you ever seen Autodesk Inventor® 

in action and wished that AutoCAD had 
the ability to do parametric drawing? Per-
haps you are not even sure what parametric 
drawing is. My guess is that once you find 
out what parametric drawings are, you’ll 
likely wonder how you worked without 
them all these years. Parametric drawing is 
the ability to add constraints to geometry 
in a drawing and then make the geometry 
react or behave in a specific way.

For example, if you change the place-
ment of a circle that might represent a 
hole in a flange or on a plate (see Figure 
3), you can force other related circles to 
update based on the original circle’s place-














Figure 2: Express Tools ribbon tab.

Figure 3: Geometric and dimensional constraints.

http://www.member.cadlearning.com
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ment. There are two types of constraints 
you can use: geometric and dimensional. 
You can also force geometry to remain per-
pendicular or parallel to each other, along 
with many other types of constraints that 
can be applied to geometry in a drawing. 
Dimensional constraints can be used to 
drive dimensional values of the geometry 
in your drawing and can also be used to an-
notate your design.

PDFs, your way
Producing a PDF file from AutoCAD 

was always left up to Adobe or a third-par-
ty utility until several releases ago when a 
dedicated plotting device to output a draw-
ing to a PDF file was introduced. This early 
PDF plotting device had some limitations 
such as producing single sheet files unless 
you used sheet sets and no way to retain 
layer information. Well that has changed 
with AutoCAD 2010. You can now use 
the PUBLISH command and the Publish 

dialog box (see Figure 4) to output multi-
sheet PDF files and decide whether or not 
layer information should be retained.

Why the focus on layer information, you 
might wonder. Well, you can now attach a 
PDF file to your drawing as an underlay just 
like you can with DWF and DGN files. To 
attach a PDF file to your drawing, you can 
use the new ATTACH command, which al-
lows you to attach a drawing or one of the 
other external reference file types. You can 
clip, control the display of layers, and ad-
just the display of a PDF underlay just like 
you would a DWF or DGN underlay. The 
new CLIP, ULAYERS, and ADJUST com-
mands can be used with xrefs, underlays, 
and raster images attached to your drawing 
to help simplify workflow.

Going organic and printing 
in 3D

3D modeling in AutoCAD is noth-
ing new—it has been around since Re-
lease 13 as part of the product and as an 
add-on prior to that. What has changed 
over the years, however, is the function-
ality offered. AutoCAD 2010 takes a  
huge step forward by introducing many 
new features that allow you to transform 
your models into organic-looking objects. 
You can convert 3D solids into meshes 
and then apply smoothing to them (see 
Figure 5), or you can create new mesh  
primitives from scratch before smooth-
ing them. Meshes can be smoothed and 
creased, and the faces of a mesh object can 
be split.

Figure 5: Transform a square, harsh model to something smooth and organic looking.

Figure 4: Enhanced Publish dialog box.

AutoCAD 2010 
takes a  

huge step 
forward by 

introducing many 
new features 

that allow you 
to transform 

your models into 
organic looking 

objects. 
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Along with being able to model new or-
ganic-looking objects, you can also modify 
3D objects much easier and print a 3D 
model using a 3D printing service or print-
er. When modifying a 3D model, you can 
now select sub-objects such as faces and 
vertices with the new sub-object selection 
filter. In addition to that, a new Gizmo and 
command are available for scaling in 3D 
and there have been some modifications to 
the 3D move and rotate Gizmos as well.

Other drafting 
enhancements 

In addition to some of the major features 
introduced in AutoCAD 2010, you will also 
find many small yet exciting changes that 
can increase your productivity. The follow-
ing is an overview of some of the smaller 
changes you might find useful.

Autodesk Seek integration – Autodesk 
Seek allows you to search an online data-
base of design-related content and insert it 
into your drawing.

Spline to polyline – The PEDIT com-
mand now allows you to convert a spline to 
a polyline object.

Reverse direction – The REVERSE com-
mand allows you to reverse the order of 
points and vertices on objects such as lines 
and polylines. Great for fixing the orienta-
tion of linetypes that contain text.

Rotate viewport – The VPROTATEAS-
SOC system variable controls whether 
you can rotate a viewport on a layout 
without needing to rotate the objects in  
model space.

Initial setup – Initial Setup allows you 
to do some basic customization of your  
AutoCAD drafting environment. It allows 
you to specify the discipline that best de-
scribes your work, which, in turn, is used 
to help locate information on Autodesk 
Seek and related partner products on the 
Autodesk.com website. Other customiza-
tion opportunities in Initial Setup include 
the ability to select which task-based tools 
you want displayed for easy access and 
which drawing template you want to use 
for new drawings.

Measure geometry – The new MEA-
SUREGEOM command combines the 
functionality of the DIST and AREA com-
mands among other functionality, into a 
new and improved command that offers 
many enhancements including visual feed-
back over its legacy counterparts.

Customization files and CUI Editor – 
Customization (CUI) files are now CUIx 

files, which contain all the elements of a 
CUI file and any bitmap files that are ref-
erenced by the commands in the CUI file. 
The Customize User Interface (CUI) Edi-
tor has been enhanced to make it easier to 
customize Quick Access toolbars (QAT) 
and define which ribbon tab should be dis-
played when the conditions for a contex-
tual tab state are met. Additionally, if you 
have any dashboard panels that you cre-
ated with AutoCAD 2008, they can now be 
migrated to ribbon panels.

AutoCAD LT 2010 enhancements – In ad-
dition to many of the new features and en-
hancements, excluding parametric draw-
ing and organic modeling, the following 
enhancements are available.

Use the ALIGN command to align ob-•	
jects in 2D and 3D.
Manage and edit block attributes with •	
the BATTMAN (Block Manager), 
EATTEDIT (Enhanced Attribute Ed-
itor), and ATTSYNC (Attribute Syn-
chronize) commands.
Edit xrefs using the REFEDIT (Ref-•	
erence Editor) command.

Compatibility with previous releases – 
Compatibility is always a concern when 
upgrading to a new release of AutoCAD. 
AutoCAD 2010 introduces a new drawing 
file format and is not binary-compatible 
with AutoCAD 2009 and other previous 
releases. You will need to use the SAVEAS 
command to save your new drawings to an 
older format when exchanging drawings 
with a client who is using an older release. 
In addition, any add-ons that were written 
with ObjectARX need to be recompiled.

Conclusion
AutoCAD 2010 offers a variety of new 

enhancements that you will find useful 
whether you work in 2D or 3D. Features 
such as improved PDF output and the 
ability to attach a PDF file as an underlay 
can greatly improve the ability to collabo-
rate with users who are using a different 
CAD program or when working on a gov-
ernment project, for example. 

For those who use AutoCAD not only 
for documenting a design, but also visual-
izing a design, the new organic modeling 
feature allows you to create more mod-
ern and natural-looking models. Auto-
CAD 2010 offers many new features and 
productivity enhancements over previ-
ous releases. To get a better understand-
ing of just how AutoCAD 2010 can help 
you become more productive, download 
the trial version from http://www.au-
todesk.com/autocad or contact your local  
Autodesk reseller. 

Lee Ambrosius is a Sr. 
Technical Writer in the 
PSEB division at Autodesk, 
Inc. and works on Auto-
CAD and AutoCAD LT. He 
is the author of two Auto-
CAD books under the For 

Dummies series, AutoCAD 2009 & Auto-
CAD LT 2009 All-in-One Desk Reference For 
Dummies and AutoCAD 2008 3D Modeling 
Workbook For Dummies. Lee can be reached 
via e-mail at lee_ambrosius@hyperpics.com; 
other contact information can be found on 
his Website at http://www.hyperpics.com or 
his Blog at http://hyperpics.blogs.com.

For those who use AutoCAD not 
only for documenting a design, but 

also visualizing a design, the new 
organic modeling feature allows you 

to create more modern and  
natural-looking models.

http://www.hyperpics.com
http://www.hyperpics.blogs.com


REVIT STRUCTURE

10 w w w. A U G I . c o m

Autodesk® Revit® Structure 2010 
has probably been the most 
anticipated release of Revit  
Structure to date. A lot of ex-

citing new features and enhancements 
make this version a “must have.” If you 
don’t know Revit Structure yet, then this 
is certainly a version you will want. The 
software’s new help feature will assist you 
while you learn the application. This help 
feature can be turned off when you think 
you know it all, and turned back on when 
you realize you don’t know everything. 

A new user interface (UI)
For the first time in Revit’s history,  

Autodesk redesigned the UI. This appli-
cation now uses the Ribbon technology. 
When I first looked at this new interface 
I had second thoughts, but after only a 
week of use, it makes complete sense why  
Autodesk took this route. 

Gone are the toolbars, menu, and de-
sign bars—the ribbon takes its place. It is 
organized into task-based tabs and pan-
els organized into typical workflows. This 
all allows for a single access point for all  
the tools.

Most of the modifiers come up in a con-
textual tab that only appears when you 

Revit  
Structure  
2010: 
A New Look  
and a Lot More

Figure 1: The new ribbon look for Autodesk Revit Structure 2010

http://www.augi.com
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select an element or a tool. In Figure 1, 
for example, I am adding a beam; note the 
task ribbon tab that appears.  

Notice that there have been changes to 
Change Element Type (formerly the Type 
Selector). Now you can see a preview of 
each family; hover longer and you get a 
larger image of it. Listed below each ele-
ment are the types for that element. 

What was once the file pulldown has 
been rebuilt and is now the Applica-
tion Menu located in the upper left-
hand corner of the application where the  
purple R is. 

A new InfoCenter has been added to 
let users have a wealth of information at  
their fingertips. 

New learning tools have been added to 
aid in the transition from Revit Structure 
2009 to 2010. Tooltips, for example, are a 
learning tool that users will find very help-
ful. This enhanced feature works when you 
hover over a command in the ribbon with 
your cursor. A quick description will ap-
pear, but wait a bit longer and a full expla-
nation of the tool appears. In some cases, 
a picture or graphic will emerge to further 
explain. If you need more info about a 
given tool, you need only hit F1 while the 
tooltip is showing and the help menu will 
open to that very topic. 

The info bar has been cleaned up and 
placed in the title bar of the application. 

 Finally, the spell checker has been re-
placed with an improved version. Some 
of the improvements include setting your 
language for the main dictionary and cre-
ating custom dictionaries. 

There is a new ribbon tab for Dedicated 
Analysis Tools. Grouping all the analysis 
tools together and organized by task such 
as creating a consistent analytical model, 
checking for required supports, adding 
boundary conditions, or even adding struc-
tural loads. 

It should be noted that Revit Structure 
2010 does not have a switch back to “clas-
sic” interface option.

Conceptual design 
environment

Now on to some of the more exciting 
new features. Conceptual Design Environ-
ment, in my opinion, will be a favorite of 
many users. Users can explore early design 
concepts before creating more detailed 
BIM models. 

What exactly is Conceptual Design En-
vironment? Glad you asked! It is a type 
of family editor that provides sophisti-
cated modeling tools and techniques for 
designers to create new massing families. 
These design concepts contain intelligent 
model data, which eliminates the need 

to recreate a design whenever a change  
needs to occur. 

The new environment contains new fea-
tures such as:

Flexible geometric form-making and •	
manipulation tools. 
Enhanced drawing environment that •	
allows drawing directly on surfaces and 
reference planes. 
Tools to divide surfaces, apply patterns, •	
and create flexible parametric compo-
nents. 
Integrated workflow with the Revit proj-•	
ect environment.

Form making is now easy. Just draw 
your shape, click a button, and your shape 
is made. Some 3D forms that can be made 
are sweeps, extrusions, and lofts. You can 

directly manipulate points, edges, and fac-
es in 3D as well. 

Surfaces now can be divided and pat-
tern complex surfaces and add building 
detail that can be later panelized (see 
Figure 3). You even can define nodes in  
your surfaces. 

Making forms is a snap now with the 
sketching enhancements. As you draw, 
automatic workplane detection occurs so 
you don’t need to always fuss with find-
ing what workplane from which to draw. 
So in 3D, you can work more effectively 
with reference planes and automatic  
workplane detection.

You can use splines with points to ma-
nipulate surfaces that are NURB-like.

The new X-ray mode allows you to 
modify points along surfaces in a en-
vironment that incorporates control  
and visualization. 

Of all these, my favorite is a new Gizmo-
like modeling modifier tool best resem-
bling the Gizmo in Autodesk 3ds Max®  
and AutoCAD®. 

Columns enhancements 
Slanted columns, a long-awaited feature 

enhancement, are finally in Revit Structure 
2010. Slanted columns (inclined, raked, 
or slanted) have to be drawn in an eleva-
tion, section type views, or even 3D views. 
After drawing them into place, just click 
them and either use the element modifi-
ers or the element properties to fine-tune 
or change the slope. Endpoint-driven and 
angle-driven controls are available.

Figure 2: A new conceptual design example.

Figure 3: Panelization of a surface.

A lot of 

exciting new 

features and 

enhancements 

make this 

version a 

“must have.”
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Columns now are cut back and set back 
when beams are adjusted using the Beam/
Column Join Editor. But it seems you 
cannot adjust the columns directly with  
the editor. 

Column Location Mark enhancement 
is now a schedule property. A label cat-
egory parameter can be used in schedules  
and tags. 

Subscription 
holders

New extensions for 
Revit Structure 2010 
are available and Con-
ceptual Form Analysis 
is one of them. Forms 
created using the new 
Conceptual Design 
tool can be opened di-
rectly in this Revit Ex-
tension and then you 
can define support 
conditions, structural 

loads, and load combinations. You will also 
be able to view tabular and graphic re-
sults. This, however, requires you to have 
the Autodesk® Robot™ Structural Analysis 
Professional 2010 software in addition to 
Revit Structure 2010.

The new Bridge Modeling extensions, 
first introduced to Revit Structure 2009 

customers with an Autodesk Subscription, 
have been enhanced further in 2010.

 These extensions allow you to model 
parametric bridge structures such as abut-
ment, road decks, piers, and bridge rail-
ings. You can now import road alignment 
from civil engineers using LandXML files.

Steel Connection Modeling extension 
allows subscription holders to model typi-
cal 3D steel connections. You will be able 
to define components for beam to column 
end plate connections, column base con-
nections and the extension will then auto-
matically create the connection using 3D 
components (see Figure 5).

Performance
Improvements to Revit Structure 2010 

give the ability to design larger, more com-
plex objects without the need to break up 
the model. In addition, the software now 
takes advantage of all the RAM on your 
computer. This is great news for all you 
64-bit computer owners. Yes, that’s right, 
Revit Structure 2010 is now a native 64-bit 
edition for Windows XP Professional 64 bit 
or Windows Vista 64 bit (Business, Home 
Premium, Ultimate editions). At last Revit 
Structure 2010 can move beyond the 4GB 
limit of 32-bit computers. 

Conclusion
I hope you enjoyed a look into the new 

features of Revit Structure 2010. Some 
new features and a lot of work lead to a 
nice looking and greatly functional appli-
cation to get those magnificent ideals de-
signed, analyzed, and documented—all in 
one application. 

Robert Coutu is a technical 
specialist for Microdesk. 
He has worked with Revit 
since 1999. In addition, Rob 
has worked with AutoCAD, 
3Ds Max, and a wide as-
sortment of other CAD ap-

plications for more than 18 years. He can be 
reached at rcoutu@microdesk.com.

Figure 4: True slanted columns!

Figure 5: Steel detailing connections possible for  Autodesk Subscription customers.
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What time is it?
It’s spring time again.  Flowers will soon 

be budding, birds are headed north, and 
Autodesk is releasing new versions of its 
software.  Impression is among those prod-
ucts that have been enhanced. It is now 
into its third release, which for me is dif-
ficult to believe. I remember when it was 
a little bit of code that could be found at 
the Autodesk Labs website.  There, it was 
allowed to cut its teeth and turn into some-
thing that has proven to be worthwhile.  

Of course, Impression has changed a lot 
since its first version.  One of the fundamen-
tal changes was in its availability—from re-
tail software to free download!  That’s right; 
Impression is a free download for those 
that are on Autodesk Subscription. (Yeah, 
there’s always a catch.)  Many people are on 
subscription now and are already using Im-
pression.  If you aren’t, then go download it 
now. I’ll wait until you get back.

What did Autodesk do?
The last version of the software, Impres-

sion 2, was a great update to the original. 

Does Impression 3 follow suit?  While Im-
pression 3 doesn’t add as many new items 
as the previous update, it does add several 
new abilities to current functions and com-
mands.   It seems that the approach taken 
was to make Impression work better with 
what it had.  Autodesk didn’t bog us down 
with new bells and whistles. Impression 

3 features enhancements to gradients, 
blocks, style controls, layers, style libraries, 
and color books, just to name a few.

Adaptive gradients
Impression users know that you can fill 

an object with a gradient fill. There have 
long been two choices for two different 

types of gradient fills, linear 
and radial. Now we have a 
third choice, adaptive gradient 
fill. Adaptive gradient fills cre-
ate a gradient fill that follows 
the outline of the filled shape. 
By contrast, the other two gra-
dient fill types disregard the 
outline of the shape. This is 
a great addition that provides 
more fill style creations.

Block 
improvements

Impression uses blocks sim-
ilarly to the way AutoCAD® 
and other Autodesk products 
use them. They allow users 

What’s New in 
Impression 3

Figure 1: This is an example of the three types of gradient fills avail-
able in Impression 3. The new Adaptive Style follows the outline of 
the object.

http://www.augi.com
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to recreate detailed objects very quickly. 
They also help to standardize visual rep-
resentations in drawings. Impression 3 has 
improved upon the way we use blocks. 
Many of the improvements allow us to eas-
ily identify and manipulate them. 

Block identification
Impression drawings will often use sev-

eral different blocks. Sometimes a quick 
revision is needed…real quick. The good 
news is that the object created was a block 
and was used in several key places. Now 
the client wants the green trees (a block) 
to be replaced with red trees. You could 
delete each block, one at a time, or use the 
block substitution tool. Okay, you did that. 
Then the same client wanted… well, you 
get the idea. 

After several block substitutions, you 
need to know which block instance was 
which when it was put in. Now Impression 
3 can tell you what’s what. Move the cur-
sor over any block and hover. While hover-
ing, a tool tip will appear that identifies the 
block for you. An icon will also appear in 
your cross hairs that will identify the type of 
block. The icon will tell you that the block 
is a standard block, a substituted block, or 
a multiblock. This enhancement makes in-
teracting with blocks much easier.

Create block from selection
The purpose of some of the enhance-

ments will be obvious as soon as I tell you 
the name of them. Create Block from Se-
lection is one of those new features. You 
could create a block from a selection in 
Impression before, but you had to jump 
through several hoops to do it. Now, sim-
ply select the objects you want in your 
block and then right-click. A menu will 
open up and one of the options is “Cre-
ate Block From Selection.” Very handy! 
Before, you had open the block pallet, se-
lect your object, and then click the create 
block from selection icon, and so on. Much 
easier now!

More global style controls
Impression 2 gave us the ability to 

“globally” resize a style. In Impression 3, 
we can now globally control the rotation of 
a style and globally control the color (see  
Figure 2). 

We could do these things before by 
changing the style settings, but now these 
two tasks can be done rather quickly. The 
global rotation and color controls work 
in the same manner as the global resize 
tool. Go to the style editor and move your 
cursor over the properties flyout arrow to 
open the flyout panel. Click the setting 
type you want to change to open the con-

trols. All three controls look and work simi-
larly. Click and drag the style control left 
or right to change the setting with a slider 
bar interface. It is very quick and easy to 
change these settings (see Figure 3).

Layer enhancements
Impression is just like AutoCAD in that 

it uses layers to manage the visual styles of 
its objects. Impression 3 has added several 
new features to its layer controls and in-
terface. Before, Impression would start a 
new file and it would not include any lay-
ers. The problem with this is that you can’t 
do anything in Impression without a layer. 
You had to make one. Impression 3 creates 
a new layer (called Layer 1 with Style 1 ap-
plied to it) when a new drawing is made. 
This saves a few steps when starting a  
new drawing.

Layer tools
These new 

layer tools will be 
very familiar to  
AutoCAD users. 
In fact, the icons 
used for them were 
borrowed from  
AutoCAD. 

In AutoCAD, 
you can isolate a 
layer, make it cur-
rent, turn it off, 
or “un”isolate the 
layer. Now, you can 
do these things in 
Impression 3. 

AutoCAD users will instantly know how 
to use these new tools. Select an object, go 
to the layer pallet, click the Layer Tools 
button, and then click the tool you want 
to use. They essentially work the same 
as they do in AutoCAD. The layer of the 
object you selected can be made current, 
turned off, or isolated. You can only use the  
“un”isolate tool if there are layers that are 
isolated, just like in AutoCAD. When us-
ing the isolate layer option, if you haven’t 
preselected an object, select your object(s) 
then either press enter to accept or right 
click to open a window for more options. 
This new window gives you the chance 
to cancel your layer isolation task (see  
Figure 4). 

Figure 2: Globally change a style’s color and its hatch rotation with a few clicks.

Figure 3: Click the text HUE OFFSET to use as a 
slider bar to change the color of the style.

Figure 4: New layer tools are similar to AutoCAD 
tools. Impression 3 will help you to work with 
layers better.
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Layer filters
Layers are essential to organizing your 

drawings’ visual styles. The more you 
have, the more you can do. Sometimes 
there are too many to handle. Impression 
3 has added Layer Filters. To filter your 
layers, select the layers you want to keep 
and press the Filter Selected Layers but-
ton. The button looks like the filter icon in  
AutoCAD. There is a second way to filter 
layers. In the layer pallet, click the Search 
box. As you start typing in layer names, you 
should notice other layers disappearing. 
Here is a list of wild-card characters that 
the layer search will understand.

To “unfilter” the layers, click the icon 
that says “Click here to show all layers.”

# (pound) Matches any numeric digit

@ (at) Matches any alphabetic character

. (period) Matches any non-alphanumeric character

* (asterisk) Matches any string and can be used anywhere in the search string

? (question mark)
Matches any single character; for example, ?BC matches ABC, 3BC, 
and so on

~ (tilde)
Matches anything but the pattern; for example; ~*AB*matches all 
strings that don’t contain AB

[ ]
Matches any one of the characters enclosed; for example, [AB]C 
matches AC and BC

[~]
Matches any character not enclosed; for example, [~AB]C matches 
XC but not AC

[-]
Specifies a range for a single character; for example, [A-G]C matches 
AC, BC, and so on to GC, but not HC

` (reverse quote) Reads the next character literally; for example, `~AB matches ~AB

Figure 5: The Layer Pallet after the layers have been 
filtered.

Figure 6: The first panel when using the Create Style Library Wizard.

http://www.augi.com
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Style library wizard
Creating style libraries is difficult in 

Impression. You essentially have to create 
each style one at a time and add them, one 
at a time. Impression 3 has added a new 
Style Library Wizard to help speed up this 
process. You begin by creating a style or 
importing an existing one. Click the “Cre-
ate Library from Style Selection” icon in 
the style pallet (see Figure 6). 

Follow the on-screen instructions. You 
begin with the starting style, specify the 

number of new styles to create, choose 
the type of color modifications to apply, 
and then determine the color modification 
rules to use (see Figure 7). 

There are a few predefined rules to 
choose from, but there are also settings 
that will change the hue, saturation, and 
luminosity levels for the new colors. Each 
new style will have the same stroke, fill, 
and other effects as the original style. It 
creates the same style, over and over again, 
but with a different color applied to it each 

time. This tool can allow you to quickly 
create several similar styles to be used in 
your drawings (see Figure 8).

Conclusion
Impression is now in its third version. 

Each new release has improved on the one 
before it. Impression is now much more 
intuitive and easier to use. The new fea-
tures that have been added to it allow users 
to create drawings more quickly and effi-
ciently than before. New layers tools that 
are nearly identical to those in AutoCAD 
have been added, giving users greater flex-
ibility when drawing and more efficient 
tools. The block enhancements help to 
streamline their use as do the new global 
style controls. Working with Impression 
has been made more efficient with this 
third release.

Brian C. Benton is a CAD 
technician and designer 
based in Fort Myers, Flori-
da, USA. Brian has been 
working with AutoCAD 
since release 10 in the me-
chanical, structural, and 

civil engineering fields. He has been a de-
tailer, drafter, designer, IT assistant, CAD 
software manager, protector of standards, 
and proverbial “Help Desk.” He can be 
reached at benton.brian@gmail.com.

Figure 7: Select the starting style and the basic rules to apply to it.

Figure 8: Change the way the color is altered with the slider bars. You will get a preview of what your new 
styles will look like. Don’t like them? Change a setting.

Impression 
is now much 
more intuitive 
and easier to 
use. The new 
features that 
have been 
added to it 
allow users to 
create drawings 
more quickly 
and efficiently 
than before.
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New Ribbon
Probably the first and most obvious 

change in Autodesk® Revit® MEP 2010 
is the new Ribbon. The ribbon features a 
streamlined user interface. It spans the top 
of the application window and replaces the 
menus, toolbars, and design bar. 

The ribbon organizes tools into a col-
lection of tabs, which represent workflows 
such as creation, annotation, or collabora-
tion. Each tab contains a series of panels, 
which are groupings of tools used to ac-
complish some part of the workflow. 

Users can set up ribbon panels in the 
order they choose. They can even “tear 

them off” to increase drawing space. The 
Ribbon supports dual-monitor workspace. 
Autodesk Revit MEP remembers where 
you placed them during the last session.

The ribbon does take some getting used 
to. I have found myself clicking on tabs in 
an attempt to find the tool that I was look-
ing for. The ribbon is contextual in that 

Get Ready for 
Revit MEP 2010

Figure 1: The new Ribbon showing the Home tab, Analyze tab, and the Manage tab.

http://www.augi.com


I s s u e  2  /  2009 1 9 

it will automatically change according to 
what tool you are using or which Revit 
MEP item is selected. 

Change is always hard and you might 
be asking, “Why this change?” It appears  
Autodesk is trying to give all Autodesk 
products that implement the ribbon a 
common look and feel. Users coming from 
AutoCAD applications will see familiar-
ity with this common thread between the  
Autodesk products. 

Application menu
In the upper-left corner of the 

Autodesk Revit MEP display, us-
ers will find the new Application 
Menu (or the big “R”), which 
provides easier access to all proj-
ect operations such as save, print, 
export, and publish. This new 
menu properly organizes these 
operations and makes Autodesk 
Revit MEP consistent with other 
Autodesk applications, making it 
easier to find the needed tools. 

Buttons at the top of the Ap-
plication Menu provide quick ac-
cess to recent or currently opened 
projects or views and the ability to 
sort your recent documents list by 
access date, size, type, and ordered 
list (see Figure 2).

Adjacent to the big “R” is the 
Quick Access Toolbar, which gives 
users quick access to the most-
used commands. The right-click 
menu includes options that enable 
users to easily remove tools from 
the toolbar, add separators be-
tween tools, and display the Quick 
Access toolbar above or below  

the ribbon.
  In addition to the right-click menu, 

the Quick Access toolbar includes a flyout 
menu, which displays a list of common 
tools that users can select to include in the 
Quick Access Toolbar. From here, users 
can also choose to display the Quick Ac-
cess toolbar below the ribbon.

 Users can add any tool they want to the 
Quick Access Toolbar simply by right click-

ing on the icon in the ribbon interface and 
choosing “Add to Quick Access Toolbar.”

Spaces enhancements
Spaces have been enhanced in two ma-

jor areas. First, the ability to create spaces 
has been improved with the addition of the 
Place Space Automatically tool. This will 
allow users to place all the spaces for the 
entire model with a single click. This is a 
huge time saver for creating spaces.

The second enhancement to spaces is 
found in the properties. The properties 
have been improved to give us the ability 
to further define the space type. The space 
type has been expanded to include energy 
analysis settings. These include the ability 
to specify an occupancy schedule, light-
ing schedule, and power schedule. These 
schedules will dictate usage percentage 
factors. If the proposed building will be 
primarily used between the hours of 8:00 
and 5:00, these can be specified and taken 
into account in analysis (see Figure 3).

Native heating and cooling 
load engine

Revit MEP 2010 has removed the IES 
loads analysis tool and replaced it with its 
own native heating and cooling load en-
gine. The new engine will allow users to 
create simple, standard, or detailed load 
reports. Users will also be able to examine 
the analytical surfaces of the model inside 
the heating and cooling loads tool to verify 
that all surfaces are being calculated cor-
rectly. This lets users examine analytical 
surfaces to ensure that interior and exte-
rior surfaces are correctly identified. Each 

Figure 2: Most file operations can be found under the Big “R.”

Figure 3: A custom Occupancy Schedule for a Space type with 
the hours set for the warehouse hours. 
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surface is color coded according to surface 
type. A warning icon will be indicated if 
Revit MEP detects a problem with the 
spaces. Possible solutions can be viewed to 
correct warnings. These additions will al-
low users to be confident about the basis 
of the calculations (see Figure 4).

This same set of tools is available if the 
model needs to export to a gbXML file for 
analysis to be run in a third-party program. 
The new and improved gbXML export tool 
now shows the analytical model and the 
gbXML settings that specify the parameter 
values used by third-party software appli-
cations when calculating energy use. 

Additional weather data
Additional weather data has been added 

to the program and can be selected and 

modified in the project information set-
tings. This allows users to specify not only 
the location of the project, but also the 
weather data for that location. Users can 
either use the default data from the par-
ticular city that has been selected or mod-
ify the dry bulb, wet bulb, or mean daily 
range. This information will be carried on 
to the heating and cooling loads analysis or 
to the gbXML export (see Figure 5).

 Enhanced multidiscipline 
collaboration 

Revit MEP 2010 is improved with the 
addition of more than 300 ASHRAE duct 
fittings and ASME pipe fittings. This will 
give users the ability to use the appropriate 
fittings that were previously unavailable. 

Users can now import building compo-
nents from Autodesk 
Inventor® or other 

mechanical applications that 
create Autodesk Exchange 
(ADSK) files. The exported In-
ventor file is intelligent. Para-
metric data is preserved. Con-
nectors are intact. Geometry 
can be enhanced with addi-
tional connectors in Autodesk 
Revit MEP.

Integration with Autodesk 
Seek has been enhanced by be-
ing able to publish or search for 
content from inside the appli-
cation. Users can publish con-
tent to Autodesk Seek from the 
Application Menu. Users can 
search for content in Autodesk 
Seek from the Insert tab on  
the ribbon.

Platform 
enhancements

Many additions have been 
made to the Revit platform and 
Revit MEP takes advantage 
of all of them. Let’s begin by 
introducing the new concep-

tual design modeling tools. This is a new 
environment that gives users the tools to 
develop conceptual mass models that can 
be converted into building components 
once loaded into a project file. These tools 
will allow users to subdivide or panelize 
the conceptual masses to begin to see con-
structability of the form.

A nice new feature for new users will be 
the enhanced tooltips. The tooltips appear 
when the cursor rolls over a ribbon icon 
button. The tooltips are multileveled in 
that more information about the tool is dis-
played the longer the cursor is left over the 
icon. New users can quickly understand 
the purpose of the commands and how 
to use them with these enhanced tooltips. 
These tooltips can be modified in the Revit 
MEP options by setting the Tooltip Assis-
tance options to None, Minimal, Normal, 
or High (see Figure 6).

Figure 4: The exterior and interior walls are detected by the analytical surfaces inside the heating and cooling loads tool.

Figure 5: The weather data for Chattanooga, Tennessee.
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The Revit 2010 platform is native 32-bit 
or 64-bit compatible. The program ships 
with one installer that will automatically 
detect your operating system and install the 
appropriate version. Native 64-bit support 
will give users the ability to design larger, 
more complex models without breaking 
them up. It will allow for improved perfor-
mance and stability in memory-intensive 
tasks such as printing, model upgrade, 
and import/export of large models. This 
allows users to take advantage of all of 
RAM on a computer, rather than being 
limited to 4GB of RAM, which is a limit of  
32-bit computing. 

Sheet or project revisions have been im-
proved by now allowing the current revi-
sion and the current revision description 

to be included in a drawing list schedule. 
Now, users can list the status of the revi-
sion on something other than the revision 
schedule on the titleblocks.

A new type of permanent hide is available 
by right clicking in a view. Users can now 
hide by filter in addition to the hide by el-
ement and hide by category. This will allow 
users to create filters and quickly hide the 
elements that are associated with the filter. 

A couple of nice new features are avail-
able when working with Worksets. First, 
in the Open dialog, if a Central File is se-
lected, users can check a new check box to 
Create a New Local Copy. This will elimi-
nate the need for users to open the Central 
File to create new local copies. 

The second nice feature when working 

with worksets is the ability to set the de-
fault worksets to open. For example, if you 
only want to open the Mechanical workset, 
you can set that as your default and Revit 
MEP will remember to always open the 
Mechanical workset until you change the 
default setting. 

A new spot slope annotation tool is avail-
able in the Revit 2010 product line. This 
tool allows users to annotate elements that 
slope. This will be a nice tool to use on 
sloped pipes. It calls out the slope and sup-
plies a slope arrow (see Figure 7). 

A halftone/underlay settings dialog is 
located in the list of settings. This allows 
users to control the darkness of underlay 
views in a view and will apply halftones to 
all underlays in the project. 

Summary
Revit MEP 2010 is loaded with new 

features. In addition to the ones I’ve dis-
cussed in this article, there is one more 

that cannot go unmentioned. 
Probably the most important 
new feature is the notable per-
formance gains for updating 
network flow, adding elements 
and connecting to networks, and  
design manipulation. 

I have found a massive im-
provement in working and ma-
nipulating pipes. Pipe acces-
sories now attach correctly and 
rarely do you have to rotate the 
accessory or manually break 
the pipe to add the accessory.  
Out of all the new features, I 
believe this will be the most 
applauded. I hope this gives 
you a sense of some of the 
new powerful features in  

Revit MEP 2010.

Mike Massey has more 
than 15 years of experience 
as an architect working on 
various project types.  
Currently, Mike is Vice 
President of Architectural 
Design Solutions for  

ALACAD, where he assists firms in assessing, 
planning, and implementing new technolo-
gy. His knowledge and enthusiasm for  
AutoCAD products runs deep as a user of 
AutoCAD since Release 9 and AutoCAD  
Architecture since its debut. He has  
developed a deep appreciation for Revit, as 
he assists firms in implementing and using 
all the Revit products. Mike is a contributing 
author for Autodesk Official Training 
Courseware and a frequent speaker at  
Autodesk University. For more of Mike’s  
tips, see his blog at http://knowingwhatyou-
dontknow.blogspot.com

Figure 6: The expanded tooltip for 
the Model In-Place tool. 

Figure 7: A sanitary pipe with the indicated slope being called out by the new spot slope tool.

http://knowingwhatyoudontknow.blogspot.com
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Editor’s note:
Ever since architectural design 

made the transition from pen, paper, 
and ink to computers, paper, and ink 
(you never really believed the hype 
about the “paperless office,” did you?) 
the one constant in the design work-
place has been change. Software tools 
evolve rapidly, and work processes 
evolve with them. Companies and in-
dividuals need to review and adjust 
methods regularly. “Am I doing this 
right?” and “Can I do this better?” have 
become part of your toolkit, like it or 
not. Those who do not keep up are left 
behind, and we all know what happens 
to slow gazelles.

Not all software changes are use-
ful or worthwhile (Vista, anyone?) and 
“planned obsolescence” can prove as 
fatal to software providers as it has 
proved for automobile manufacturers. 
Autodesk, to the company’s credit, 
leads from the front by involving us-
ers in discussions about their products 
and relying on extensive beta testing 
before release. 

This year sees the Revit platform 
adopting the Ribbon interface, in 
the cause of an integrated look and 
feel across all Autodesk applications. 
That desire for congruity alone does 
not justify change that will certainly 
confuse existing users. In this col-
umn we examine the new-look Revit  
Architecture to see if the interface 
changes actually promote efficiency. 

–Chris Fox, AUGI Revit Editor

Order from the menu, or a 
la carte?

The first Revit window that opens in a 
standard installation, Recent Files, has 
changed appearance. It’s horizontally orga-
nized now. You can open previous project 
of family files by picking thumbnail icons 

or file names, as before. There is a link to 
Autodesk’s Web Library. 

The first differences to note: no menus 
visible, only two toolbars and the Ribbon. 
The red R icon at the upper left of the 
screen opens the application menu. This 
takes the place of the former File menu, 

All Done Up  
in Ribbons
A Look at the new 
Revit Interface

Figure 1: The application menu showing various configuration options.
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and is the only menu you will use. 
At the bottom of the menu on the left 

is Close. This is the only way to close a file 
other than closing all windows. At the bot-
tom right is Options. 

Personally, having worked as a produc-
tion drafter and designer for years, I am 
glad to see cascading menus depart; I hat-
ed having to slow down my cursor speed or 
make three picks to reach a tool, especially 
as monitors reached sufficient size. Actions 
you perform dozens of times a day, if they 
can be made even a second faster, not only 
save considerable hours over the course 
of a project, but keep the working rhythm 
lively. You know what I mean—once you 
know where a tool is, you want to find it 
without looking, like cymbals in a drum kit, 
or sockets in a ratchet set.

You can toggle the right pane list from 
Recent Documents to Open Documents, 
which allows you to use the application 
menu to switch views in open files with-
out having to open the View tab. You can 
sort Recent Documents by Date, Size, and 
Type. You can pin documents to the list, 
so they do not disappear if you work in  
many files.

With the list options, I’d call the appli-
cation menu an improvement over the old 
file menu.

Raising the bars
Speaking of clicking tool icons by reflex, 

Revit’s exposed toolbars have departed ex-
cept for the Quick Access Toolbar at the 
upper left and the InfoCenter at the up-
per right of the screen. The Quick Access 
Toolbar holds common tools: Open, Save, 
Undo, Redo, Modify, 3D View, and Syn-
chronize with Central. You can turn on 
File>New, and you can add tools from the 
ribbon to the Quick Access Toolbar with a 
right-click option. You can relocate the QA 
toolbar below the ribbon rather than at the 
top of the screen.

You will use the QA Toolbar, because 
this is the only place Undo and Redo ap-
pear. It’s also the fastest way to open the 
default 3D view or make a perspective, 
and the fastest way to save. If you make 
New visible, beware that it sits next to 
Open, and you may finding yourself wast-
ing time opening empty files rather than 
searching inventory.

Modify appears on the QA Toolbar so 
you can always reach it. As I’ll explain later, 
Modify is not always where you expect it 
on the ribbon (see Figure 2).

The InfoCenter, upper right of the 
screen, is a search and connection tool. A 
search field will show results in local instal-
lation help files and also online. The Com-
munication Center radar icon is on this 

toolbar, and does not spout annoying bub-
bles. The help icon at the right side holds 
a drop-down list. Two listings will help if 
you are spooked by the interface changes: 
User Interface Overview and Where is My 
Command? Who says Autodesk program-
mers don’t have a sense of humor?

The Quick Access toolbar suffices; some 
place on the top of the interface has to 
hold the constant items. I don’t like New 
and Open sitting next to one another, and 
I’d like to have Close exposed, but I can 
understand why the programmers did not 
do that first time out.

Less is more
Once you’re inside a project file, other 

changes become apparent: no Design Bar, 
no rows of toolbars. The drawing screen 
is correspondingly wider, and optionally 
taller, than before. 

The Ribbon holds eight tabs. Each tab is 
divided into panels of grouped tools. The 
titles of all are visible all the time. You can 
minimize the ribbon tabs in two stages, 
if you want to give yourself more vertical 
screen space for the drawing area. In es-
sence, the design bar is now horizontal.

The big deal with the ribbon is the 
simplified arrangement of tools and the 
heightened graphics. No tool duplicates, 
and very few show when not in use. Wall 
appears in one place only, as does Refer-
ence Plane. There are no editing tools at 
all: Move, Copy, Rotate, and all the oth-
ers do not occupy the screen unless items 
are selected. Tools on the Modify tab 
are all for changing model geometry and  
graphic display.

Tool icons are all bigger and more color-
ful, and Tooltip assistance has been mark-
edly enhanced. Hold your cursor over a 

tool icon, and you may be surprised at the 
cascading graphics. Once you decide you 
don’t need all the pictures, you can tone 
down Tooltip Assistance in the Options 
dialog. Remember, that’s on the applica-
tion menu now.

You will clearly not use all the ribbon 
tabs to the same degree, and you cannot 
reorder them, to push Collaborate, say, or 
Massing & Site, to the far right. If you have 
a very small screen, the ribbon display will 
truncate to icons only.

Context is all
So, how do you copy something if there 

is no Copy tool? This is where the ribbon 
actually works a little differently from the 
old design bar. 

Figure 2: The Quick Access Toolbar; this image has 
been condensed.

Figure 3: InfoCenter and Help

Figure 4: Tooltips
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Any time you start a placement tool—
Wall, for example—a context tab opens 
with controls, options, and tools. The Op-
tions Bar also activates. The context tab 
holds the Type Selector, Draw options, and 
the Element Properties button. This but-
ton is split; you can open Instance or Type 
Properties directly. Modify sits to the left 
of action context tabs. 

Whenever you select items, another con-
text tab appears. This tab holds editing op-
tions: Move, Copy, Rotate, Mirror, Array, 
Scale, Pin, and Delete. The Type Selector 
and Element Properties choices appear 
when applicable, and Modify tools specific 
to the element (Edit Profile and Attach 
for walls, for example). Create Similar and 
Group are in a Create panel, Cut and Clip-
board Copy appear in a Clipboard panel, 
and there is a panel for graphic overrides. 
Selection context tabs do not have Modify 
present, which is why it also appears on the 
Quick Access menu.

You can switch to other tabs while con-
text tabs are open. You do not have to 
finish a floor sketch, for example, to load 
in a family or change views, but you can-
not start placing walls with an unfinished 
sketch.

We don’t have space for a tab-by-tab 
review, but I’ll mention that the View 
tab contains the most tool buttons; here 
you control graphics, create views, set up 
sheets and switch windows. Switch Win-
dows is a tool I would put on the Quick 
Access Toolbar right away: too many clicks 
otherwise to reach something one uses 
constantly (see Figure 4).

Finally, an interface you can 
customize

One slick feature of the ribbon: you can 
undock individual panels so they function 
as floating toolbars. You can locate them 
outside the Revit window; same with the 
Project Browser and dialog boxes. I finally 
could afford dual monitors last year (and 

paid for them before the crash!), so I’m 
looking forward to spreading Revit out a 
little and keeping exposed the tools I want 
out in the open. 

Check out the vids, kids
Don’t take my word for this. If you do 

not have Revit 2010 installed somewhere 
in your office, take a look at the new inter-
face in action.

Autodesk has posted an official video 
about the new interface at http://adt_blog.
typepad.com/between_the_walls/2009/03/
autodesk-architectural-products-user-in-
terface-video-tours.html 

or 
h t t p : / / w w w. y o u t u b e . c o m / w a t c h 

?v=afQOYjQ_peY.
David Cohn, an independent Revit blog-

ger, has posted a review video of the new 
interface: http://revit-up.blogspot.com.

By the time this article is published, oth-
er reviews will undoubtedly be available.

Chris Fox is the Revit edi-
tor for AUGIWorld, and 
has written numerous ar-
ticles on Revit Architec-
ture, Revit Structure and 
Revit MEP. He has written 
Autodesk Official Training 

Courseware for Revit Architecture and Revit 
Structure. His book Introducing and Imple-
menting Revit Architecture 2009 is pub-
lished by Autodesk Press. Chris records in-
struction videos on Revit for CADLearning. 
Chris recently moved from the US to Austra-
lia, and leads training classes in Revit 
through corporate, university and technical 
school contacts there. You can reach him at 
chris.fox@archimagecad.com. 

Figure 6: The Room & Area panel, undocked.

Figure 5: The Home Tab and two Wall context tabs.
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The 700 
Pound 
Gorilla

K
ing Kong it’s not, 
but Autodesk has fi-
nally polished up the 
new “King” in the 
3D modeling world. 
As some lament the 
death of Mechanical 
Desktop, many more 

have seen Inventor grow up and become 
the successor to a legend in the mechani-
cal design world. With all the new features 
that have been added to the latest release, 
we should be able to wait patiently for the 
next hundred pounds.

There are so many enhancements to  
Autodesk Inventor® 2010 that I could prob-
ably fill the entire issue. As a result, I’m 
choosing what I consider to be the “cream 
of the crop” features needed for the average 
user to achieve even greater productivity.

The ribbon
Like most Autodesk products for 2010, 

the user interface has been retooled and 
now sports the Ribbon. The Classic UI 
has been retained and the ribbon may 
be swapped out by accessing the toggle 
in Tools > Application Options > Colors. 
While the ribbon may seem daunting, 

don’t ignore it in favor of the Classic UI 
as the ribbon will be needed as new fea-
tures are added to Inventor. But for now, 
you have the choice of using the Ribbon or 
the Classic UI. 

New features workshop
The very first stop to make after you have 

installed Inventor 2010 should be to Help 

http://www.augi.com
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> New Features Workshop. New Features 
Workshop may be accessed by picking the 
dropdown menu from Help.

Take the time to go through EVERY 
segment of the Workshop. In this Help 
segment, new features are grouped for 
your ease in locating items that are of sig-
nificance to your workflow.

Assembly enhancements
My eyes were drawn to the new en-

hancements for productive assembly de-
sign. Topping the list of enhancements are 
new and expanded productivity tools, en-
hanced pattern capability, enhanced con-
straint highlighting, and Shrinkwrap.

The productivity tools that have been 
added or improved for 2010 include the 
ability to rename browser nodes using 
one of three naming schemes. Compo-
nents within the browser may be re-
named by filename, part number, or the  
default name.

Add Part and Add Sub Assembly  
permit creation of parts and subassem-
blies within an assembly file using a  
streamlined workflow.

Save and Replace saves a copy and re-
places the current component with the 
saved copy. Ground and Root Component 

selects a component within an as-
sembly and moves and grounds the 
component at the assembly origin.

Component Derive allows sub-
stitution of a component with a 
derived version. Place At Compo-
nent Origin allows placement of 
a new component at the selected  
component’s origin.

For those who have difficulty un-
derstanding and managing assembly 
constraints, there’s the option to dis-
play component names with the con-
straints in the model browser. This 
option is available in Application Op-
tions > Assembly.

Degree of Freedom Analysis displays 
a dialog that lists the number of trans-
lational and rotational degrees of free-
dom for all of the occurrences in the  
active assembly.

For those dealing with Level of Detail 
Substitutes, you now have the ability to up-
date or create substitutes on the fly within 
an assembly.

Other goodies included in Inventor 
2010 assemblies are the ability to pattern 
an existing component pattern, enhanced 
constraint highlighting, a new axial mate 
icon within the model browser, assembly 
browser restructuring, user-defined brows-
er folders, and the ability to shrinkwrap  
an assembly.

Bills of materials
There are several enhancements to 

the Bills of Materials in Inventor 2010. 
We’re now able to edit in the Bill of Ma-
terials dialog box with a workflow similar 
to Microsoft Excel. In addition you can 
now open any file from within the Bill of  
Materials dialog.

New is the opportunity to custom-
ize the Bill of Materials columns to suit 
your needs. This customization may now 
be exported to an external XML file that 
may be imported into other assemblies. 
Thumbnails and highlighting between the 
BOM dialogue and the model browser are  
also supported.

AEC Exchange
AEC Exchange functionality has been 

expanded in this new version. Previous 
versions allowed conversion to AutoCAD 
DWG files. Autodesk Inventor 2010 pro-
vides exporting in the new .ADSK format 
utilized by other Autodesk software— 
Autodesk Revit and Autodesk Revit MEP 
at this point. 

You are now able to export building 
components, check your de-
sign against Revit standards, 
create connections and a user 
coordinate system in your 
translated components, pro-
duce and manage shrinkwrap 
substitutes for smaller file 
size, and create component 
properties on the fly. All of 
this is supported by an AEC 
Exchange browser.

Content Center
If you are a stand-alone 

user, and you don’t want to 
have the memory overhead of 
ADMS on your system, then 
Desktop Content Center is 
for you.

With Desktop Content Center, admin-
istration will be a breeze and Content 
Center speed will be improved, with lower 
memory requirements. All libraries will be 
saved and accessed on your local disk, with 
no need to connect to the server. This is 
of great benefit for those with laptops who 
need to travel away from the office.

Content Center configuration is aid-
ed by the use of a number of new tools. 
You may review all the libraries available 
in the library storage location. Sorting of 
listed libraries by the names and proper-
ties are now available. To add a new library 
to your current configuration, you merely 
need to check the boxes of the libraries 
that you wish to use in the current con-
figuration. You may also transfer libraries 
between the Desktop Content location 
and your Vault server by using the Library  
Transfer Guide.

For those users wishing to change the 
materials within library content, the Mate-
rial Guide will do just that. Once library 
content has been moved to a read/write li-
brary, you may use the Guide to easily add 

Figure 1: Accessing Help

Figure 2: Constraint relationships

With Desktop 
Content Center, 
administration 
will be a breeze 
and Content 
Center speed will 
be improved, with 
lower memory 
requirements.
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materials to existing families. All selected 
members of a family that are altered will 
be created as copies of existing families.

In previous versions of Inventor we have 
been able to place Content Center com-
ponents as custom parts. In 2010, we can 
place custom Content Center components 
as standard parts.

All Content Center components can now 
be refreshed and updated to new members 
upon placement, or you may update them 
manually. New browser icons for Content 
Center components distinguish between 
standard Inventor parts and Content Cen-
ter members.

Translators!
Previously available from the Autodesk 

Labs website, we now have the ability to 
translate Catia version 5 model and as-
sembly files directly to Inventor parts and 
assemblies. Not forgotten are new transla-
tors for UGS, Solid Works, and other Para-
solids-based parts and assemblies as well as 
Pro/E Wildfire parts and assemblies. A JT 
translator is also included in the package.

An exciting new addition to Inventor 
2010 is the ability to open an Autodesk 
Alias .wire file, and have the Alias file be 
associative within Inventor. As changes are 
made to the original Alias file, the linked 
file may be updated from within Inventor.

Drawing enhancements
Dual dimensioning is now available in 

Hole, Chamfer, Bend, and Punch notes. 
Dimensions may be edited immediately 
upon placement rather than use the old 
RMB edit technique.

View geometry may now be projected 
into a sketch that is associated with a view. 
The projected geometry remains associ-
ated to the parent view geometry.

Dimensions may now be applied to 
spline points and minimum/maximum 
XY values. Dimensioning may be accom-
plished using either ordinate or general 
dimension types. 

Additional symbols have been added 
into the list of symbols for feature control 
frames. Now, a simple check mark controls 
which symbols will be available.

Feature Control Frames are now aligned 
with the symbol box above the datum. Op-
tionally, you may also position the datum 
box on the leader side. You may install the 
ESKD support add-in, which will create 
an ESKD Annotate tab in the Ribbon.

For those users who employ a large  
number of symbols in their drawings, 
we now have a way to manage the chaos.  
Inventor 2010 supports user-defined sym-
bol folders within individual files and tem-
plates. This will allow organization of sym-
bols of similar  type.

Parts and more parts
One of the biggest news flashes for In-

ventor 2010 is in the area of parts. Inven-
tor now supports multi-body parts. In the 
past, only sheet metal supported multi-
body parts in the form of the folded and 
unfolded versions of a single part.

Multi-body parts greatly enhance top-
down design in that we can create multiple 
solid bodies within a single part file and use 
the Combine command to join, cut, or in-
tersect the bodies into one part (shades of 
Mechanical Desktop!) Other normal mod-
eling commands such as Split or Derive 
may also be used. Multi-body parts allow 
easy plastic part design and enhance the 
Tooling add-in for the creation of molds 
and fixtures.

The Derive command may now be used 
on a part file that already contains a solid. 
This workflow allows for Boolean opera-
tions within a single part file. Because of 
multi-body integration, bodies may be 
moved within an individual part file by 
free drag or specified offset value along an 
origin axis.

Another new aspect of Inventor 2010 
parts is the ability to create plastic features 
within a part file. This ability was pre-
viewed in last year’s Autodesk Labs release 
of Inventor Plastics.

For lofts, the addition of a context menu 
greatly improves the performance and ease 
of use. The context menu allows selection 
on the fly of such things as Edge Chain, 
Section Selection, Rails, and Centerline 
selection, eliminating the need to return to 
the dialog box each time you change the 
selection type.

iFeature enhancements include the abil-
ity to create an iFeature from an existing 
iPart. During the creation process, a table-
driven iFeature may be created by select-
ing the included features from the model 
or the browser. You may also include iFea-
tures within an iPart table. 

iFeature custom properties may be made 
available within a consuming part file. When 
you insert the iFeature into a part file, cus-
tom iFeature properties will be added to 
the custom property tab of the part.

Sketching
Improvements in sketching include the 

use of sketch blocks, use of arcs in a 3D 
sketch, addition of the Apply option in the 
scale command, removal of the Bowtie op-
tion in splines (now available in the root 
context menu), and a new command - Sil-
houette Curve.

The Silhouette Curve command is avail-
able within a 3D sketch. This command 
permits the creation of a natural 3D part-
ing line around the outside boundary of 
a surface, along the direction vector. This 
silhouette curve may be used to create a 
boundary patch surface, or to use the Split 
command along with the new Split Solid 
Option to create two separate bodies.

Styles
Users may now modify the unit types for 

Material Properties. Supported are most 
Metric and English unit type standards. 
When changing unit formats, the current 
values are converted and displayed in the 
selected metric for English unit format. 
Weight, Volume, and Pressure unit for-
mats are available.

Put it in the Vault
Unfortunately, time and space in this is-

sue make it impossible to cover every sin-
gle new feature in this mammoth release. 
However, I must mention that we now have 
multiple options and versions in Autodesk 
Vault. While the standard Vault remains 
on the DVD, we now have options for 
purchasing intermediate steps in the Vault 
family. Options include Vault Workgroup 
with revision control and Vault Manufac-
turing, (formerly ProductStream). Contact 
your reseller for more information on the 
differences between these products.

Dennis Jeffrey is an  
Autodesk Inventor Certi-
fied Expert and Autodesk 
Implementation Certified 
Expert. He is the founder 
of Tekni Consulting LLC, a 
firm specializing in Au-

todesk Manufacturing Solutions implemen-
tation, training and consulting. Dennis has 
been using Autodesk Mechanical 3D  
Products since 1987. He is the author of  
Creative Design With Mechanical Desk-
top™ and Creative Design With Autodesk 
Inventor, with a new co-authored book, 
Mastering Autodesk Inventor 2009 now 
available at Sybex.com. Dennis is a modera-
tor for the AUGI manufacturing forums as 
well as an AUGI Wish List reviewer and col-
umnist. He can be contacted at  
djeffrey@teknigroup.com.

For those users 
who employ a 
large number of 
symbols in their 
drawings, we now 
have a way to 
manage the chaos
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AUTODESK INVENTOR

When creating a new part with Au-
todesk Inventor®, a sketch pad opens. This 
is where you lay out the outline of your 
geometry that you will need to extrude, ro-
tate, sweep, etc., to create the first feature 
of your solid model. If you are accustomed 
to working with AutoCAD®, you will need 
to adjust your thinking cap a bit. You start 
by drawing or sketching what you need 
for your design. Then add constraints and 
dimensions after the geometry has been 
drawn or sketched.

Constraints—what, why, 
and how

A constraint is a control that is needed 
to constrain the geometry. Got it? NO? A 
constraint is how geometry is related to 
other geometry within your sketch. Bet-
ter? I hope so. Geometry related to other 
geometry… think about that for a minute. 
Well, parallel, perpendicular, concentric, 
linear — isn’t that how a line is related or 
constrained to another line? Concentric, as 
with two circles, or a circle and an arc?

A fully constrained 
sketch means that there 
are no “floating” geom-
etry entities. I’ll define 
floating with this exam-
ple: if I were to grab an 
end point, center point, 
or part of the geometry 
(line or circle), I could 
pull it or stretch and drop 
in a new location. Noth-
ing will change on its own 
later in my design. I’m 
sure most of us have been 
working on a design, and 
then it suddenly changes 
and we have no idea why. 
Just a sudden click on 
something and the geom-
etry changes. If you fully 
constrain your sketch, 
and all sketches, then that 
magically changing part 
tends not to happen with 
inadvertent mouse clicks 
later on.

I start at the origin (X, Y, Z are all 0), 
and create my first line, used for a center 
point for a circle or arc. From there, I con-
tinue rough drawing the rest of my geom-
etry. Some constraints are being applied as 
I continue my sketching. You will see an 
icon pop up with your cursor as you cre-
ate your lines, circles, and arcs. Those are 
some basic constraints, such as perpendic-

ular, parallel, tangent, concentric, and end 
points that are coincident. There may be 
another constraint or two also applied. You 
will have to apply others as needed to fully 
constrain the sketch, which we will discuss 
in further detail. See Figure 1 for the icons 
in the constraint tool bar.

I have completed my rough sketch (it is 
rough as there are no dimensions, and not 
all the geometry is constrained). See Fig-
ure 2. See the line with the arrow point-
ing to it? That is the line I am construct-
ing— it is being constrained parallel to the  
bottom line.

Hint:  If you need the new line to be 
parallel or perpendicular to a specific line, 
start your new line, then momentarily hov-
er your curser above the line to which you 
want your new line to be parallel or per-
pendicular. The corresponding constraint 
will show above the line. 

The first line you create, if horizontal 
or vertical, will automatically have an as-
signed constraint. I will describe later how 
to show constraints and how to remove 

unwanted constraints (see 
Figure 3).

Warning:  Be care-
ful how you  create your 
lines. When you are plac-
ing lines at angles, you 
might get angled lines 
that could be created par-
allel or tangent to other 
angled lines already on 
your sketch. What I do is 
exaggerate what the angle 
is, then assign a dimen-
sion to correct the angle 
that I need.

Once you have finished 
your sketch, the next op-
eration is to lock the point 
at the origin. If you look 
in the lower right corner, 
there is a message that 
determines how many di-
mensions are needed to 
fully constrain the sketch 
(see Figure 4). I continue 
adding dimensions or 

A Lesson in Constraint 
Fundamentals

Figure 1: Constraint Toolbar

Figure 2
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constraints as needed to fully constrain my 
sketch, and looking in the lower right cor-
ner, the number of dimensions continues 
to decrease to 0. 

As you add a dimension, 
the number decreases by 
one. Adding constraints 
may decrease the num-
ber by more than one. As 
soon as I locked the point 
at the origin, the number 
went from 12 to 10. 

The first line I sketched 
was a vertical line from the 
origin. That line and the 
point at the origin turned 
black— those are shown 
as constrained. When 
a drawing is fully con-
strained, all the geometry 
is black. Before placing 
dimensions, I try to apply 
all my constraints first. If I 
need two lines that are in-
line with each other, I use 
the “co-linear” constraint. 
If I need two lines to be of 
the same length, I might 
use the “equal” constraint. 
An alternative to the equals: when dimen-
sioning the second line, you can select the 
dimension from the first line. That will also 
make the two lines equal.

When placing points or circles in your 
sketch, you may need them to be vertical 
or horizontal to each other; I use those 
constraints. You could also use a vertical 
and horizontal dimension to locate each 
point, as well. I normally use constraints 
and use fewer dimen-
sions, to keep my sketch 
less cluttered. 

If I need to adjust the 
features later, it is easy 
to remove or delete con-
straints, then add a differ-
ent dimension as needed. 
Dimensions are like con-
straints in that they both 
determine the variance 
of one piece of geometry 
to the other.  If you try 
to place a constraint that 
has already been set, you 
get an error message (see 
Figure 5). 

Just select “cancel” and 
continue. A fully con-
strained drawing might 
look like Figure 6. That 
has dimensions and I have 
shown all constraints.  
Also, in the lower right-

hand corner, the message is “Fully Con-
strained” and all the geometry is black.

Hopefully, you now have a good basic 
understanding of constraints. There will 

be a time when you need 
to delete one and change 
to a different constraint, 
or you need to add a di-
mension to redefine how 
that feature is needed.

I prefer to use Show 
Constraint for a single 
piece of geometry. Refer 
to Figure 1—next to the 
“constraints” icon is the 
“Show Constraints” icon. 
Select the Show Con-
straints icon, then select 
the piece of geometry 
for which you need to 
modify the constraint. A 
Constraint Bar pops up, 
with all the constraints 
that are associated to it. 
Right-click, select Done, 
click on the constraint 
you need to delete, and 
then press the delete 
key. That piece of geom-
etry should turn green, 
which means it needs 

to be constrained. Change to what you 
need, and it should turn black. Congratu-

lations! Your drawing is now fully  
constrained again.

Follow up
 Constraining geometry is add-

ing relationships between the dif-
ferent parts of geometry in your 
sketch—similar to adding dimen-

sions. In some cases, you 
can reduce the number of 
dimensions needed, thus 
“uncluttering” your sketch 
while still maintaining de-
sign intention.
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Figure 4: Dimensions or Constraints Needed

Figure 5: Constraint Error
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